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Warning
Please pay attention to the following issues when purchasing or using the product:

There are small components included in this kit. Swallowing mistakenly or misoperation can
cause serious infection and be even fatal. When an accident occurs, please seek medical
assistance immediately.
Please place the product in a safe place where an under-6-year-old cannot touch, who should
not use or approach the product.
Juveniles should use the product with their parents.
Do not place the product or the components near any AC socket or other circuits, in case of
potential risks of electric shock.
Do not use the product near any liquid or flame.
Do not use or store the product in an extreme environment such as extremely cold or hot
and heavily humid.
Please remember to power off when the product is not in use.
Do not touch the moving or rotating part of the product.
The product may get heat at some part, which is just normal. But misoperation may cause
overheat.
Misoperation may cause damage to the product. Please take care.
Do not connect the positive and negative poles of the power inversely, or the devices in the
circuit may be damaged.
Please place and put the product gently. Do not smash or shock it.

About
Adeept is a technical service team of open source software and hardware. Dedicated to applying
the Internet and the latest industrial technology in open source area, we strive to provide best
hardware support and software service for general makers and electronic enthusiasts around the
world. We aim to create infinite possibilities with sharing. No matter what field you are in, we
can lead you into the electronic world and bring your ideas into reality.
The code and circuits of our product are open source. You can check on our website:

www.adeept.com

If you have any problems, feel free to send an email for technical support and assistance:
support@adeept.com

On weekdays, we usually will reply within 24 hours. Also welcome to post forums on our
website.

http://www.adeept.com
mailto:support@adeept.com
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Copyright
This user manual can be used for learning, DIY, refitting, etc., except for commercial purpose. The
Adeept Company owns all rights of contents in the manual, including but not limited to texts,
images, data, etc. Any distribution or printing should be implemented with the permission of the
Company, or it will be deemed illegal.
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Components List
Acrylic Plates

A01
1pcs

A02
1pcs

A04
1pcs

A05
1pcs

A06
1pcs

A07
1pcs

A03
1pcs
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The acrylic plates are fragile, so please be careful when assembling them in case of breaking.
The acrylic plate is covered with a layer of protective film. You need to remove it first.
Some holes in the acrylic may have residues, so you need to clean them before the use.

Machinery Parts

Electronic Parts

A11
1pcs

X1

www.adeept.com

X16

M2
Nut

www.adeept.com

X24

M3
Nut

www.adeept.comwww.adeept.com

X4

M3*4
Screw

www.adeept.com

X10

M2*14
Screw

www.adeept.com

X20
www.adeept.com

X4

M3*12
Copper
Standoff

www.adeept.com

Adeept UNO R3 Board X1 Adeept Harp Driver Board X1

M3*6
Copper
Standoff

X12

X3

A08
1pcs

A12
4pcs

M3*30
Copper
Standoff

www.adeept.com

M3*12
Screw

M3*8
Screw

A09
1pcs

A10
1pcs
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2-Pin Wires X1

Adeept RGB LED Module X1

Laser Receiver Module X1

3-Pin Wires X4

Laser Emission Module X1

Adeept Speaker Module X1

9V Battery Holder X1

Adeept Button Module X3
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Large Cross-head Screwdriver X1

Large Blade-head Screwdriver X1

USB Cable x1

Tools
Cross Socket Wrench X1

4-Pin Wires X1

9-Pin Wires X1
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Self-prepared Parts
You need to prepare two types of battery: 9V battery (larger capacity rechargeable ones are
recommended for longer time of operation) and 7-12V (500mA or higher) AC-to-DC adapter
(power adapter).

9V Battery X1

7V-12V AC-to-DC adapter(US Standard) X17V-12V AC-to-DC adapter(EN) X1
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About the Adeept Laser Harp Kit
Overview
The Adeept Laser Harp Kit is a harp without strings, with bright laser beams used instead. You
only need to pluck the laser beams to play a piece of music as done with strings.
Functions
1. When you switch on the laser harp, it's in the state of standby. Only three button modules and

the power indicator of the speaker module are on.
2. In the standby state, press and hold the white button for 3s, then the laser and the RGB LED

light up. So the harp is turned on. Press and hold the button for another 3s, the laser and RGB
LED will dim. The harp will return to standby.

3. When the harp is on, press the white button and the LED will turn to red. Now the harp is in
the bass of C chord. Block the laser beam left to right and the harp will ring different bass
sounds when the light changes colors.

4. When the harp is on, press the blue button, the light will turn to green and the harp is in the
alto. Block the beams, the harp will make different alto sounds with the light changing colors.

5. When the harp is on, press the red button, the light will shine blue and the harp is in the
soprano. Block the beams, the harp will make different soprano sounds with the light changing
colors

7. When the harp is on, turn it upside down and it will turn to the standby state. Turn it back
again and it's switched on.

8. Adjust the volume of the speaker. Rotate the R3 potentiometer on the speaker module to
adjust the volume.

Code:
You may change the parameters in the code below to adjust the sensitivity of the laser harp.

Uncomment the variable defined to select a major chord.
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Notes: (please read carefully the following items before powering on the system)
1. Don't shine the laser at eyes.
2. You may adjust the R14 potentiometer on the Laser Receiver Module to adjust the sensitivity
of R7 photo-resistor receiving laser beams.
3. Please do not change the parameters randomly (generally as 650-1000) when adjusting the
sensitivity of the 6 photoresistors to detect laser. You're recommended to read the data collected
by the photoresistors respectively by serial ports, values including val, val2, val3, val4, val5, and
val6. Set the app values then: app, app1, app2, app3, app4, and app5, which should be slightly
smaller than values read via the serial ports.
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4. When the power is on, if you turn the harp upside down, the laser will be off and the buttons
are not available.
5. You're recommended to use rechargeable 9V lithium battery with a large capacity. But
batteries cannot supply the laser harp for a very long time. An external power would be better.

6. The laser harp cannot work in a low battery.
7. When the harp is on, initially the light will light up red and the harp is in bass state.
8. After the assembly is done and you power on the system, sometimes the laser beams are not
shining on the photoresistor. In this situation, you may adjust the photoresistor gently with the
blade screwdriver. Be careful not to scrape the board. Do not move the laser emitter module if
not necessary, in case the module is damaged or peeled off.
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Laser Emission Module x1

2 Pin Wires x1

Effect diagram of other modules:

3 Pin Wires +
Adeept Button Module

For easy understanding,
subsequently only the

port part of the wire will
be shown instead of the

whole cable.
9 Pin Wires +Laser Receiver Module

4 Pin Wires +Adeept RGB LED Module

Assembly
Preparations before Assembly
A. Connect all modules with the wires.

3 Pin Wires +Adeept Speaker Module

3 Pin Wires +
Adeept Button Module

3 Pin Wires +
Adeept Button Module

Assemble the following components

Effect diagram after assembling
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Don't install the M3*8 Screws and M3*6
Copper Standoffs inversely.M3*6 Copper Standoff x4

M3*12 Screw x1

M3 Nut x1

A06 x1

Assemble the following components Effect diagram after assembling

Servo Adjustment
A. Fix 4 M3*6 Copper Standoffs onto the A08 plate.

B. Fasten the A06 and A08.

Effect diagram after assemblingAssemble the following components

M3*8 Screw x4

A08 x1



www.adeept.com

11

M3*12 Screw x2

Laser Emission Module x1
M3 Nut x2

Assemble the following components

C. Fix 2 M3*12 Screws onto the Laser Emission Module.

D. Fix 2 M3*12 Screws onto the Laser Receiver Module.

M3*12 Screw x2

Effect diagram after assembling

Laser Receiver Module x1

M3 Nut x2

Assemble the following components

Effect diagram after assembling
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M3*30 Copper Standoff x3

Do not assemble the M3*8 Screws and M3*30 Copper Standoffs inversely. Also pay
attention to the holes position.

E. Fix 3 M3*30 Copper Standoff s onto A03.

Effect diagram after assembling

A03 x1

Assemble the following components

M3*8 Screw x3
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Assemble the following components

M3*30 Copper Standoff x1

M3*8 Screw x1

F. Fix 1 M3*12 Copper Standoff on the A03 plate.

Effect diagram after assembling
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Assemble the following components

G. Assemble Laser Receiver Module onto A03.

Effect diagram after assembling

M3 Nut x2
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Effect diagram after assembling

H. Assemble the Laser Emission Module to the A03 plate.

Assemble the following components

M3 Nut x2
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Assemble the following components

A01 x1

M3 *8 Screw x3

I. Fasten the A01 plate and the M3*30 Copper Standoffs.

Effect diagram after assembling
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M3 *12 Screw x2

J. Assemble A01 and A06.

A01

A06

M3 Nut x2
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Assemble the following components

Here A4 is made orange for better
understanding. Subsequently similar
adjustments (colorful modules) will
still exist for the same reason. The
physical objects prevail.

M3 Nut x2

K. Fasten A04 and A06.

A04 x1

Effect diagram after assembling

M3 *12 Screw x2

A06 x1
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Assemble the following components

A06

A09 x1

M3 Nut x1

L. Assemble A09 and A06.

Effect diagram after assembling

M3*12 Screw x1
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A04

A10 x1

M3*12 Screw x1

Effect diagram after assembling

M3 Nut x1

M. Fasten A10 and A04.

Assemble the following components
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M2 Nut x2

Effect diagram after assembling

A10M2 Nut x2

N. Assemble 2 M2*14 Screws to the Adeept Button Module.

Assemble the other Adeept Button Modules in the same way.

O. Assemble the Adeept Button Module and the A10 plate.

Do not assemble M2*14 Screw and M2
Nut tight. Keep some space for the
subsequent assembly.

Effect diagram after assembling

Assemble the following components

M2*14 Screw x2

Assemble the following components

Adeept Button
Module x1
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Fasten the other two Adeept Button Modules and A10 similarly.

Effect diagram after assembling

Effect diagram after assembling
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M2*14 Screw x2

M2 Nut x2

Effect diagram after assembling

P. Install the Adeept RGB LED module to A05.

A05 x1

Assemble the following components

Adeept RGB LED x1

A12 x2
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M3 Nut x2

Effect diagram after assembling

Q. Then fix A02 onto A05.

Assemble the following components

A02 x1

M3*12 Screw x2
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A06

R. Insert the bulging part of plate A11 into the hole on A06.

Effect diagram after assembling

Insert the bulge of
A11 into the hole on
the A06. Keep the
A11 flexible and do
not fix it currently.
Just keep the whole
part flat.

A11 x1
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M3*12 Copper
Standoff

M3*8 Screw x1

S. Assemble the part finished in step Q and the part done in step R.

Assemble the M3*8 Screws and M3*12 Copper Standoffs, the M3*8 Screw and the M3
Nuts.
Tips: First place the part finished in step Q flat, place the M3 Nut into the slot of A04, then
put the part finished in step R into that done in step Q, and insert the M3*12 Screw into
the M3 Nut and tighten them. At last assemble M3*8 Screw and M3*12 Copper Standoff.

M3 Nut
x3

A04

M3*12
Screw x3

Assemble the following components

Effect diagram after assembling
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M3*6 Copper Standoff

Effect diagram after assembling

T. Assemble the Adeept UNO R3 Board to the M3*6 Copper Standoffs.

M3*4 Screw x4

Adeept UNO R3 Board x1
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Assemble the following components

U. Then insert the Adeept Harp Driver Board onto the Adeept UNO R3 Board.

And connect the cable of assembled modules to the Adeept Harp Driver Board.

Assemble the following components

Adeept Harp Driver Board x1
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Circuit Connection
Connect components based on the figure.
Pay attention to match the wire and port and not connect inversely.
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In this view the square hole is
on the left side. Pay attention
and do not assemble the
Adeept Speaker Module on
the other side of A07.

In this view the square hole is
on the left side. Pay attention
and do not assemble the
Adeept Speaker Module on the
other side of A07.

Adeept Speaker Module x1

A12 x2

A07 x1

V. Assemble the Adeept Speaker Module and A07.

Assemble the following components

M2 Nut x2

Assemble the following components

M2*14 Screw x2
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A05
A06

M3 Nut x4
M3*12 Screw x4

Assemble the following components

W. Assemble the plates A07, A05 and A06.

Wire the Adeept Speaker Module and the Adeept Harp Driver Board.

Assemble the following components
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Assemble the following components

9V Battery Holder x4

X. Insert the 9V Battery Holder into the harp.

Assemble the following components

Organize the wires of modules and insert the 9V Battery Holder into the harp. Then insert
the plug of the battery holder into the Adeept UNO R3 board.



www.adeept.com

33

Software & Hardware
What is Arduino?

Arduino is an open-source electronics platform based on easy-to-use hardware and software.
Arduino boards are able to read inputs - light on a sensor, a finger on a button, or a Twitter
message - and turn it into an output - activating a motor, turning on an LED, publishing something
online. You can tell your board what to do by sending a set of instructions to the microcontroller
on the board. To do so you use the Arduino programming language (based on Wiring), and the
Arduino Software (IDE), based on Processing.

Over the years Arduino has been the brain of thousands of projects, from everyday objects to
complex scientific instruments. A worldwide community of makers - students, hobbyists, artists,
programmers, and professionals - has gathered around this open-source platform, their
contributions have added up to an incredible amount of accessible knowledge that can be of
great help to novices and experts alike.

Arduino was born at the Ivrea Interaction Design Institute as an easy tool for fast prototyping,
aimed at students without a background in electronics and programming. As soon as it reached a
wider community, the Arduino board started changing to adapt to new needs and challenges,
differentiating its offer from simple 8-bit boards to products for IoT applications, wearable, 3D
printing, and embedded environments. All Arduino boards are completely open-source,
empowering users to build them independently and eventually adapt them to their particular
needs. The software, too, is open-source, and it is growing through the contributions of users
worldwide.

Why Arduino?
Thanks to its simple and accessible user experience, Arduino has been used in thousands of

different projects and applications. The Arduino software is easy-to-use for beginners, yet flexible
enough for advanced users. It runs on Mac, Windows, and Linux. Teachers and students use it to
build low cost scientific instruments, to prove chemistry and physics principles, or to get started
with programming and robotics. Designers and architects build interactive prototypes, musicians
and artists use it for installations and to experiment with new musical instruments. Makers, of
course, use it to build many of the projects exhibited at the Maker Faire, for example. Arduino is a
key tool to learn new things. Anyone - children, hobbyists, artists, programmers - can start
tinkering just following the step by step instructions of a kit, or sharing ideas online with other
members of the Arduino community.
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How Should I Use Arduino?
If you are a beginner with Arduino, Arduino learning kits on our website www.adeept.com would
be a prefect step into this fantastic field!

One type of Arduino board are used in this kit: Adeept UNO R3 board

Power

The Arduino/Genuino Uno board can be powered via the USB connection or with an external
power supply. The power source is selected automatically.

External (non-USB) power can come either from an AC-to-DC adapter (wall-wart) or battery. The
adapter can be connected by plugging a 2.1mm center-positive plug into the board's power jack.
Leads from a battery can be inserted in the GND and Vin pin headers of the POWER connector.

The board can operate on an external supply from 6 to 20 volts. If supplied with less than 7V,
however, the 5V pin may supply less than five volts and the board may become unstable. If using
more than 12V, the voltage regulator may overheat and damage the board. The recommended
range is 7 to 12 volts.

The power pins are as follows:

Vin. The input voltage to the Arduino/Genuino board when it's using an external power source
(as opposed to 5 volts from the USB connection or other regulated power source). You can supply
voltage through this pin, or, if supplying voltage via the power jack, access it through this pin.

5V. This pin outputs a regulated 5V from the regulator on the board. The board can be supplied
with power either from the DC power jack (7 - 12V), the USB connector (5V), or the VIN pin of the
board (7-12V). Supplying voltage via the 5V or 3.3V pins bypasses the regulator, and can damage
your board. We don't advise it.

3V3. A 3.3 volt supply generated by the on-board regulator. Maximum current draw is 50 mA.

GND. Ground pins.

IOREF. This pin on the Arduino/Genuino board provides the voltage reference with which the
microcontroller operates. A properly configured shield can read the IOREF pin voltage and select
the appropriate power source or enable voltage translators on the outputs to work with 5V/3.3V.

http://www.adeept.com
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Input and Output

Each of the 14 digital pins on the Uno can be used as an input or output, using pinMode(),
digitalWrite(), and digitalRead() functions. They operate at 5 volts. Each pin can provide or
receive 20 mA as recommended operating condition and has an internal pull-up resistor
(disconnected by default) of 20-50k ohm. A maximum of 40mA is the value that must not be
exceeded on any I/O pin to avoid permanent damage to the microcontroller.

In addition, some pins have specialized functions:

Serial: 0 (RX) and 1 (TX). Used to receive (RX) and transmit (TX) TTL serial data. These pins are
connected to the corresponding pins of the ATmega8U2 USB-to-TTL Serial chip.

External Interrupts: 2 and 3. These pins can be configured to trigger an interrupt on a low value,
a rising or falling edge, or a change in value. See the attachInterrupt() function for details.

PWM: 3, 5, 6, 9, 10, and 11. Provide 8-bit PWM output with the analogWrite() function.

SPI: 10 (SS), 11 (MOSI), 12 (MISO), 13 (SCK). These pins support SPI communication using the SPI
library.

LED: 13. There is a built-in LED driven by digital pin 13. When the pin is HIGH value, the LED is on,
when the pin is LOW, it's off.

TWI: A4 or SDA pin and A5 or SCL pin. Support TWI communication using the Wire library.

The Uno has 6 analog inputs, labeled A0 through A5, each of which provide 10 bits of resolution
(i.e. 1024 different values). By default they measure from ground to 5 volts, though is it possible
to change the upper end of their range using the AREF pin and the analogReference() function.

There are a couple of other pins on the board:

AREF. Reference voltage for the analog inputs. Used with analogReference().

Reset. Bring this line LOW to reset the microcontroller. Typically used to add a reset button to
shields which block the one on the board.

Arduino Software (IDE)
Arduino Software (IDE) is used to write and upload the code for Arduino Board. First, install
Arduino software (IDE): visit https://www.arduino.cc/en/Main/Software. Download the
corresponding installation program according to your operating system. If you are a Windows
user, please select the “Windows Installer” to download and install the driver correctly.

https://www.arduino.cc/en/Main/Software
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After the download completes, run the installer. For Windows users, there may pop up an
installation dialog box of the driver during the installation. Please agree the installation when it
appears.

After installation is completed, an Arduino software shortcut will be generated on the desktop.
Run the IDE.

The interface of Arduino software is as follows:
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The Arduino Integrated Development Environment - or Arduino Software (IDE) - contains a text
editor for writing code, a message area, a text console, a toolbar with buttons for common
functions and a series of menus. It connects to the Arduino and Genuino hardware to upload
programs and communicate with them.

Verify: Checks your code for errors when compiling it.

Upload: Compiles your code and uploads it to the configured board.

Before uploading your sketch, you need to select the correct items from the Tools > Board and
Tools > Port menus. The boards are described below. On the Mac OS X, the serial port is probably
something like /dev/tty.usbmodem241 (for an Uno or Mega2560 or Leonardo) or
/dev/tty.usbserial-1B1 (for a Duemilanove or earlier USB board), or /dev/tty.USA19QW1b1P1.1
(for a serial board connected with a Keyspan USB-to-Serial adapter). On Windows, it's probably
COM1 or COM2 (for a serial board) or COM4, COM5, COM7, or higher (for a USB board) - to find
out, you look for USB serial device in the ports section of the Windows Device Manager. On
Linux, it should be /dev/ttyACMx, /dev/ttyUSBx or similar.

Once you've selected the correct serial port and board, press the upload button in the toolbar or
select the Upload item from the Sketch menu. Current Arduino boards will reset automatically
and begin the upload. With older boards (pre-Diecimila) that lack auto-reset, you'll need to press
the reset button on the board just before starting the upload. On most boards, you'll see the RX
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and TX LEDs blink as the sketch is uploaded. The Arduino Software (IDE) will display a message
when the upload is completed, or show an error.

When you upload a sketch, you're using the Arduino bootloader, a small program that has been
loaded on to the microcontroller on your board. It allows you to upload code without using any
additional hardware. The bootloader is active for a few seconds when the board resets; then it
starts whichever sketch was most recently uploaded to the microcontroller. The bootloader will
blink the on-board (pin 13) LED when it starts (i.e. when the board resets).

Note: If you are using an external programmer with your board, you can hold down the "shift"
key on your computer when using this icon. The text will change to "Upload using Programmer".

New: Creates a new sketch.

Open: Presents a menu of all the sketches in your sketchbook. Clicking one will open it
within the current window overwriting its content.

Note: Due to a bug in Java, this menu doesn't scroll; if you need to open a sketch late in the list,
use the File | Sketchbook menu instead.

Save: Saves your sketch.
Serial Monitor: Opens the serial monitor.

Additional commands are found within the five menus: File, Edit, Sketch, Tools, and Help. The
menus are context sensitive, which means only those items relevant to the work currently being
carried out are available.

Since version 1.0, files are saved with an .ino file extension. Previous versions use the .pde
extension. You may still open .pde named files in version 1.0 and later, and the software will
automatically rename the extension to .ino.
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Install Library
The example sketches provided use the MsTimer2.ZIP library, so you need to install it before
compiling. Click Add.ZIP Library to add theMsTimer2.ZIP library to the libraries folder.

After the library is installed successfully, you can find the MsTimer2.ZIP library under
Sketch->Include Library
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Upload Program
After the preparations above, next we will upload the program (example sketches provided) to
the Adeept UNO R3 board.

Open the program provided for the control board, the file “AdeeptLaserHarp.ino”.

Connect the Arduino UNO R3 board to the PC. Select Tool -> Board “Arduino/Genuino Uno”, and
Port - > COM5. Also here is COM5, assigned to the Uno, but it can be COM1, COM2, COM3...
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Click the button to upload the sketch to the board.
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Afterword
Thanks for purchasing our product and reading the manual! If you spot any errors or have
any ideas or questions for the product and this guide, welcome to contact us! We will
correct them if any as quickly as possible.

After completing all projects in the guide, you should have some knowledge of the book and
Arduino, thus you can try to change the robotics into other projects by adding more Adeept
modules or changing the code for extended functions.

For more information about Arduino, Raspberry Pi, smart car robot, or robotics, etc., please
follow our website www.adeept.com. We will introduce more cost-effective, innovative and
intriguing products!

Thanks again for choose Adeept product!

http://www.adeept.com
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